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  Pyramix 6.1 MR1 Release Notes 
 
 
 

 
 

Installation 
 
Please consult the Installation Guide located on the Pyramix Installation Media (CD/DVD-ROM or USB 
Memory card) for details of the hardware and software installation procedure and Authorization Key 
registration process. 

 
To install the Mykerinos board, TURN YOUR COMPUTER OFF (shut down then switch the power off). 
Next plug the Mykerinos board into one of the PCI/PCI-Express bus slots on your computer and turn the 
power back on. 
  

Additional installation step for multi-board application 

 
In order to enable multi-board operation, all Mykerinos cards in your PC have to be connected together 
using a special HDTDM ribbon cable. This cable has to be plugged into the multi-pin connectors located 
on the top edge of the I/O daughter cards. Please contact your Merging Technologies Sales Partner for 
information on how to order this HDTDM ribbon cable. 
 

• To install the Pyramix Virtual Studio software insert the Pyramix Virtual Studio Installation Media - 
the installation program should auto-start. 

• To install MassCore launch the MT Security Settings, go to the MassCore page and install the 
MassCore RunTime (a MassCore base key is required). 

 
 

 

Updates 

  
 Please check our Web site http://www.merging.com periodically for information, patches and updates. 
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Version Pyramix 6.1MR1 

 
Improvements 

 
 

� Automation: Erase Points in selection option was added in the track header Automation options 
(MT3211) 

 
� Automation: Workflow Improvements (MT2921 & MT2517) 

� The Copy/Cut/Paste Automation now works between different Mixers of different projects 
and between strips that do not have the same buses panner. I.e. Pan automation track can 
be copied to a stereo track having a Balance. It only works in the usual cases listed below.  

• Pan -> Balance 

• Balance -> Pan 

• LeftRight mono surround panner -> Pan 

• LeftRight mono surround panner -> Balance 

• Pan -> LeftRight mono surround panner 

• Balance -> LeftRight mono surround panner 
 

Limitation: Only in the case of a Mono Strip Pan copied to a Surround stereo panner, will 
we only carry the left side of the stereo strip’s surround panner.  

 
� Added menu option: “Automation > Bus Reassignment on Paste” to enhance the automation 

workflow between two projects. 

• The Automation > Bus Reassignment left side window, shows the buses automation 
data of the clipboard. 

• The Automation > Bus Reassignment right side window, shows the available buses 
of the current mixer. 

• When this On/Off menu is enabled, a window will open to show the automated 
buses elements under Clipboard and the Destination Mixer Buses. 

• When this On/Off menu is disabled, a window will open only if a Bus in the 
Clipboard has no Destination Bus. 

 
By default, the “Automation > Bus Reassignment” dialog assigns together the buses 
which are matching by Bus type.  

 
This dialog allows: 

• The Copy an automation track from/to different or similar Buses type of a strip. 
When type of buses are (i.e. SR1 to ST1) 

• The Copy an automation track from/to different type of strips (mono, ms, stereo and 
GPS).  

 
� Mixer 

� Input Strip Mode Stems entry: 
The Strip Usage Type menu (above strip's input connectors) now shows one entry per Stem 
for Multi-Stems buses. Since effect inserts on Multi-Stems buses are Stem based, this is 
necessary to guarantee proper delay compensation when dealing with multi-stem Buses. 
 

� Internal Bus display name: 
If an Internal Bus is connected to a bus output, the Bus name will now be appended to the 
Internal Bus displayed name. (MT3176)  
 

� Panning: More useful pan defaults for channel to surround bus routing (MT2440) 

• Default Panning for Surround on a mono track  FRONT/CENTER 

• Default Panning for Surround on a stereo track should be LEFT/L - Right/R 
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� The Delete and Erase Automation functions were rename in the Automation menu and in 

the track header Automation (A) context menu as: 

• Delete points & Interpolate (Was before “Delete Selected points”)  

• Delete points (Was before “Erase Points in Selection”) 

 
 

BUG FIXES  (some fixed bugs could be missing from the list) 

 

 
� MT3251: Fixed. End Record Dubbing crash when without ADR key 
� MT3248: Fixed. Cannot set the Delay Compensation to OFF in the Settings page (it reverts to full 

compensation) 
� MT3244: Fixed. Mixer problems when the ASIO buffer size is bigger than 1 TC frame (1920 

samples) 
� MT3237: Fixed. VST Buffer size value if changed is not kept when re-starting Pyramix 
� MT3221: Fixed. Pyramix: Mykerinos TimeCode settings we cannot enable the "Burn in Window" 

option 
� MT3289: Fixed: Mixdown: Crash when doing a Mixdown to MXF file format 
� MT3231: Fixed. Un-patching Live in Dubbing Mode doesn't un-patch the Direct Record 
� MT3229: Fixed. Some project causes small pauses after a locate or play/stop 
� MT3235: Fixed. Crash in Fade Editor if deleting clips in a project. 
� MT3226: Fixed. Crash deleting un-mounted clips with library open (out of memory 
� MT3183: Fixed. Document library: Cannot trim recorded clips in document library 
� MT3230: Fixed. Some project will not relink to Medias unless deleting the _quickmount or refreshing 

Media manager. 
� MT2354: Fixed. Fade Editor: Memory settings are lost if closing and opening the Fade Editor. 
� MT3223: Fixed. Strip Input/Repro connection from the track header above 128th strip was not 

possible 
� MT3222: Fixed. Record does not record in dubbing mode and under some  project creation 

conditions 
� MT3190: Fixed. Safe Record: recording is interrupted by any audition command in the fade editor 
� MT3119: Fixed. Random crash when going into the Route Mixer page 
� MT3156: Fixed. Duplicated media mount / unmount can lead to offline media (no waveform, no 

sound) 
� MT3196: Fixed. Snapshot to library will crash if template-project dates from an older Pyramix version 
� MT3153: Fixed. Archive: Give back mount error "Some Media Files referenced by some Clips of 

your project are currently not accessible" 
� MT3145: Fixed. MT Asio Bridge: named Bank 0, 1, 2 etc. they should be named as the inputs MT 

ASIO 1, 2, 3 etc 
� MT3208: Fixed. Media manager: Crash when trimmer is playing back and you switch folder in media 

browser 
� MT3203: Fixed. VST plug-ins do not work for strips placed after a Direct Monitoring strip 
� MT3202: Fixed. Fade Editor: when Fade Editor is open, PMX might crash while changing the 

timeline events 
� MT3198: Fixed. Record not aligned if it was started during playback 
� MT3177: Fixed. Chase through Sony 9pin results in 1 frame offset 
� MT3166: Fixed. AMR utility crashes when converting files (in convert.dll) 
� MT3130: Fixed. Record: Pyramix crash when using the "Quiet If Creation Fail" option and enabled 

dubbing 
� MT3197: Fixed. Random crash on record stop 
� MT3181: Fixed. Stereo Panning On/Off state issues with Ramses 
� MT3138: Fixed. Delay Compensation and effects inserts on multi-stems buses induces a wrong 

delay compensation computation   
� MT3193: Fixed. Chase keyboard shortcut is assigned to the Internal and the Active machine 
� MT3182: Fixed. Browsing the Media Manager browser will result in unwanted and incomplete 

mounted folders. 
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� MT3158: Fixed. Archive: If the project contains Media in an un-mounted folder, archive will give an 
"invalid path" error and auto-mount an empty folder 

� MT3155: Fixed. Clean Up Media function no longer working in Pyramix v6.1 (From Media Menu) 
� MT3154: Fixed. Automation engine frozen after an automation write only if a .pml is open by the 

.pmx 
� MT3149: Fixed. Random Mixer load crash due to a VST plug-in 
� MT3148: Fixed. Randomly, Pyramix crashes when opening a project and loading strips 
� MT3147: Fixed. Timeline: Adding clip to current selection range using Shift my hang Pyramix 
� MT3143: Fixed. Crash on Quick Import 
� MT3129: Fixed. Render-Mixdown: Waveforms While Recoding option when using DSD medias into 

DXD project will show noise in waveforms 
� MT3117: Fixed. Automation: Delete automation when track not connected to mixer should auto-

ripple 
� MT3110: Fixed. Automation: cannot use delete auto-ripple if timeline tracks are not connected. 
� MT2910: Fixed. VS3 effects: Remote initialization problem when several panels 
� MT2354: Fixed. Fade Editor: Memory settings are lost if closing and opening the Fade Editor. 
� MT2954: Fixed. Digitizing session Auto Stop Record on input levels conditions
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Pyramix V6 Specific Known Issues (Some issues could be missing from this list) 

 
� MassCore 

� Hyperthreading is supported for MultiCore processors only, since Pyramix V6.1 
� MassCore is not supported on a Pentium 4 or Pentium D processor, refer to the Installation 

Guide for the proper supported configuration details. 
� We recommend that you do not use more than 65-70% of the Core resources, to avoid 

intense graphic refresh burst related problems. Three safe core zones have been set. 
Eventually this will be optimized further. 

• 0% to 65% Green zone (best performance) 

• 65% to 75% Orange zone (moderate risk) 

• 75% to100% Red zone (performance could be at risk if major screen redraws are 
initiated by the user).  

� If the Core indicator blinks (red), this will indicate a drop, only be concerned if the drop 
occurred during Playback/Mix down or record. To reset the Core drop simply do a Mouse 
click on the Core indicator, for more information please refer to the appropriate section in the 
User Manual. VST plug-ins users should consult the VST Core Load information also 
available in the User Manual. 

� External Insert plug-ins: The same input and output cannot be used in the External Insert 
plug-in and the Mixer at the same time, they are exclusive to either one. 

� The MADI 1 daughterboard is not supported in multi-board, neither in Mykerinos nor 
MassCore. 

 
 

� General 
� Pyramix v6.1MR1 projects will not be backwards compatible with the previous Pyramix 

v6.1.6 release. In order to open such projects in the previous release, please make sure that 
you perform a Save Special “Save as Version Pyramix V6.1.6”. 

� Low Memory Condition Warning:  
A warning was added to inform users when the system is reaching Low Memory Conditions. In 
order to save a project under such conditions Pyramix will switch to Save to Disk mode as not 
enough memory might be available otherwise. This warning was added in order to prevent a 
Runtime Error on Save.  
 
Note that the Save time in Save to Disk mode in Low Memory Condition might take a longer time 
since the memory is being dumped to disk in order to allow the users to save their projects. We 
recommend afterwards to exit and restart Pyramix in order to free all memory. 
 
This Low Memory warning threshold can be adjusted by the user if one wishes it to come earlier 
or later. With every systems and workflows being different, Merging leave you the ability to 
adjust when the Warning will show up.  

 Procedure: 

• Close Pyramix 

• Type regedt32 in the run command 

• In the registry go to HKEY_CURRENT_USER\Software\Merging 
Technologies\Pyramix\Settings\Save to disk threshold (this key will only appear if at 
least one save was made using that version) 

• Default value in Decimal mode has been set to 15  
- The higher the value is set, the earlier the Low Memory warning will come 
- The lower the value is set, the riskier it is for you to encounter a Runtime Error at 
save (previous Pyramix versions value would have had this value set to 0) 

 
In the near term, Merging expects to significantly further improve (reduce) the memory 
consumption of Pyramix, especially when confronted with the task of loading enormous libraries, 
over the coming months. Since this is a rather major re-design, we decided however not to further 
postpone the release of Pyramix V6.1 for just this very only annoyance.  
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For the long term, the move of our applications to a 64 bit operating system will provide a very 
solid platform to accommodate the ever growing project size requirements of some of our users. 
We are extremely committed to this move but we do need to be clear that it will not be a short 
term solution, current plans put such a move around 12 months away from today and potentially 
towards 2011. 

 
� Timeline and Realtime Sampling Rate Conversion: clicks may occur when doing playback or 

mixdown in a region where 2 overlapping clips reference the same media with different 
sampling rate than project. 
Workaround: Convert those medias to the project's sampling rate, prior to using such a 
workflow. 

� Waveforms Display while recording: Some systems configurations will not be adequate for 
true performance if the Waveforms Display while Recording option is selected in the 
Pyramix>Playback/Record settings. Mainly due to the Graphic taking too much resources, in 
such case the stop recording might not be responsive. We recommend in such case that 
you disable this option in your Pyramix Settings. 

� Cannot use DiskWrite with Pyramix v6.1: You will need to either re-install Pyramix (maybe 
run clean up after un-installing Pyramix). Or get a way to Re-install the Gear driver only.  

� ADR keyboard is by default disabled. To enable it you must download and run the proper 
Registry Key.  http://download.merging.com/beta/AssociatedTools/ADRKeyboard.zip 

� Quickmount generated with V6.1 will not be compatible with previous Pyramix released 
versions. Remove the Quickmount file if opening a referenced media folder in a previous 
release. 

� Multiple projects opened simultaneously: We do not recommend users to have more than 8 
project opened at the same time (due to GDI object limitation). 

� Waveforms: Pyramix V6.1 has a new waveform file format that is PK2, such a PK2 
waveform file cannot be read in previous Pyramix version and in such a case waveforms will 
have to be re-generated. On the other side previous waveforms format PK files (Pyramix 
V6.0 and older) are compatible with Pyramix V6.1. 

� The Render Tool will create a temp file for the CEDAR and Nova v0.99 in C:\  Be aware that 
Merging cannot change the Temp file patch of such third party Render. 

 
� Third Party Plug-ins 

� Algorithmix ReNOVAtor for Pyramix: A new version is available with Memory improvements. 
This version will prevent memory related crashes and can be downloaded from 
www.algorithmix.com  

� Cedar: Install issue on certain Vista configurations where you might not see the Cedar plug-
ins after the installation process. The problem is due to erroneous referencing of the license 
manager utility on a vista machine. Please contact Merging Support or Cedar Support for all 
details and workaround. 

� Cedar: Some toolbar icons might be missing if on a Windows XP system. Workaround: 
Disable the Skin option in Pyramix>settings>Desktop Layout. 

� Altiverb: We recommend users to download the latest version available on the Audio Ease 
site. 

� The Waves plug-ins build v6.0.5.1 are known to maybe cause random crashes when 
rebuilding the Pyramix Mixer. This issue is being looked at by the Waves team and Merging 
and is still under investigation. 
 

� MP3, AC3 Files and other compressed formats support:  
� Default Windows installation should handle most of the common compressed file formats. In 

case of problem with the default Widows Installation, Merging has a list of recommended 
third-party codecs but will not certify any codecs. 
http://forum.merging.com/viewtopic.php?f=18&t=5755 

� Vista users warning: UAC (User Account Control) can be blocking the “Essentials Codec 
Pack” at startup. If this is the case, you should see once logged into your session at the 
windows bottom bar a “Windows has blocked some programs” message. You can then 
unblock it from there or deactivate UAC from the Windows Control Panel. 
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� No need to install the previous mp3 beta handler since it is now by default part of the 
Pyramix installer. 

 
 

� Hardware 
� Intel DX58SO Motherboard incompatibility of Windows Vista SP1/SP2 versions:  

A conflict has been reported and is under investigation (as of sept 2009) between 
motherboards using the latest Intel chipset X58 and Mykerinos PCIe cards (such as MYK-
X30) under Windows Vista SP1 and/or SP2 versions. Pyramix users with such 
configurations should remain with the non-SP version of Vista for the time being. 
Incompatibility of Mykerinos MYK-X50 and X58 chipset based motherboards: a conflict has 
been reported and is under investigation (as of sept 2009) between motherboards using the 
latest Intel chipset X58 and Mykerinos PCIe MYK-X50 cards. Pyramix users with MYK-X50 
are advised to only use them in X48 chipset based motherboards for the time being.  
MYK-X30 and Mykerinos PCI cards are not subject to this problem. 
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Version Pyramix 6.1 

 
 

 
NEW FEATURES 

 

Version Pyramix 6.1 RC1 
� New Waveforms in background Utility 

� The Pyramix installer includes a new Waveforms Generator Utility that allows the user to 
generate waveforms for a desired folder without needing to run Pyramix, simply select the 
folder where the waveforms are to be generated (this only works for PK2 new waveform 
format). 

 

Version Pyramix 6.1 Beta3 
� Automation: New “Erase Points in Selection” option 

� This option in the Automation menu will not add points at the extremities of the selection 
range. It will simply interpolate with the closest present points out of the selection range, it 
behaves as if using the eraser (Shift + Alt) to remove each points. 

 

Version Pyramix 6.1 Beta2 
� Recording 

� New Display of Waveforms While Recording 

• Waveforms are now being drawn during the recording 

• Supported for all formats 

• This default mode can be disabled if going in Settings>Application>Playback/Record 
 

� New Safe record mode 

• Available from the Internal Machine menu by enabling “Safety Record”. You will 
then see an “S” overlaid on the record button. 

• When in “Safety Record” mode the only way to stop the recording is to go back to 
the internal machine menu and de-activate "Safety Record".  

• Safety Record restricts all actions that stop the record function, including cursor 
movements with the mouse and commands from any remote control device 
(Ramses/Isis) 

 
� On the fly media Sampling Rate Conversion 

� Clips that do not match the project sampling rate will now play in pitch and for their original 
length if placed in the timeline  

� This option can be enabled or disabled under Settings>Application>Playback/Record 
� A Medium or High Quality conversion option is available under 

Settings>Application>Playback/Record 
� Pyramix SRC now works for all audio file formats 
� We warn the users that for now the SRC (if enabled) will not be applied to the Embedded 

Interchange exports. Meaning that clips with a mismatched sampling rate in the timeline of a 
project to be exported will not be converted through the SRC module to match the target 
export’s sampling frequency. 

 
� Remote Control - Machine (MT2413) 

� New options in the Settings>Remote Control>Machine under Properties see some new 
Sony Machine Edit Record options 

• Inhibit Video Record 

• Inhibit Timecode Record  

• Inhibit Assemble Record 
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� Direct Monitoring Strip 
� The Direct monitoring setting was first introduced for input strips in Pyramix 6.1 beta 1; this 

setting aimed at providing a way to have the minimum delay through strips, typically useful 
when recording and sending live headphone or monitor mixes (e.g. for a musician’s return). 
This setting will “disable” the delay compensation for a single strip.  

� Since the beta2 three Direct Monitoring strips were added (to make sure that the users do 
not make Mixer configuration errors) 

• Direct monitoring strips 

• Stereo monitoring strips 

• MS Direct monitoring Strips.  
� These new strips are just like normal input strip, with the restrictions below: 

• You cannot insert VST Effects 

• You cannot send them to an AUX or Subgroup 
� Notes: 

• In a typical Recording -Mixing workflow, the user would likely need such strips 
during the recording session phase and later reuse these same strips for 
Playback/Mixing. Right clicking on a Direct Monitoring strip will let you convert the 
DM strip into the equivalent of a normal input strip. 

• Since Direct Monitoring and Return strips are not intended to be used in Repro 
mode for playback with the associated track, connecting a track to such a strip’s 
connector will automatically change the input mode to Live input mode. 

• A Direct Monitoring strip can be converted to a normal input strip. Be aware that an 
Input Strip cannot be converted back to a Direct Monitoring. 

 
� ADR improvement 

� Added Beep Track option (registry key needed HKEY_CURRENT_USER\Software\Merging 
Technologies\Pyramix\ADR). Key settings below. 

• Special Beep Strip Input = 0 for normal mode. 

• Special Beep Strip Input = “X” to send a beep (all) on the “X” physical input of the 
mixer. 
 

� GPIO 
� GPI/O support is available as a Remote Controller module. Find complete details in the User 

Manual. 
� Create a fader start with Pyramix and the GPIO Option and GPIO Interface (MT:2131) 

• In the GPIO mapping dialog (All Settings > Controller Mapping > "GPIO" > Settings), 
e.g. map a fader gain to a GPO output pin, it will afterwards do a fader start. 

 
 

Version Pyramix 6.1 Beta1 
� Mixer: New Auxes Management, sub group are now available (MT001903) 

� Sub Groups consists in special Aux buses which are automatically routed to buses, just like 
normal strips, instead of having output connectors. This does not replace the existing Aux 
(now renamed as Aux Sends), but brings a quicker, more efficient and straightforward way 
to manage FX channels (e.g. for Reverb plug-ins or any VST/VS3 plug-in used as Send FX): 
no more need for additional return strip. Additionally this also allows the use of Post Fader 
effects. 

 
� Mixer: Added Direct Monitoring option Mixer Strip (MT002479). 

� This is still under development. To bypass the delay compensation on a chosen strip simply 
select “Direct Monitoring” in the strip input dropdown menu section. The strip will in this case 
be non-compensated so that the talent can monitor the audio coming from that strip aligned 
on the Bus master monitored output. In such a case you must make sure that no Effects 
requiring delay compensation are inserted on that Bus. 

                                                                                                          
� Mixer: New Peak Logger (MT002343) 
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� Peak levels above a specified threshold can be logged and displayed in a dialog window 
with TimeCode, source (Strip of bus's channel) and peak level.  

� The Peak Logger Dialog is available in the right side tootltip menu of Faders row.  
 

� Mixer: New Global status button for Solo, Mute and Overload 

� These buttons are located on the right side of the mixer (next to the fader line) and will 
respectively display if one Mute, Solo or Overload led is ON. Click on it will reset the related 
state. 

 
� VS3 ASIO Bridge (MT002288): 

� ASIO application's output may be merged into Merging's MassCore engine and I/O 
� This new VS3 ASIO Bridge option must be enabled in the VS3 control Panel 
� You must chose the number of desired I/O in the VS3 control Panel (to a maximum of 

32channels) 
� In the Pyramix Mixer connect the proper "VS3 ASIO Bridge" Input or Output 

 
� Support for compressed format ingestion (e.g. Mp3 & wma, request ID:MT000027) 

� It is now possible to mount to Pyramix and Ovation compressed audio files. The 
decompression is handled via Microsoft DirectShow technology. So the format supported 
depends on locally installed DirectShow codec. By default, Windows supports wma and 
mp3, but a large variety of codec exists to support all majors compressed format. 

• Settings: The user should setup the default decompression cache options in all 
Settings>Application>Location to specify where the media should be decompressed 
when no Mounting rules are specified (see mounting rules).  Afterwards click on 
“Decompression Settings” to access the decompression cache settings. From the 
“Decompress Files” dialog box, you can choose between 3 decompression options. 

• In addition to general settings, mounting rules can be created to bypass the default 
decompression cache options specifically for a Mounting point: 

• See the Pyramix User Manual for complete details. 
 

� Authoring: 
� Convert Text Markers to CD Disc (MT002302):  

• Access: in the Marker Tab, Right-click menu on a selection of Text Markers > 
Create CD Disc 

• A new CD disc will be created and selected, with CD markers matching Text 
Markers timecode positions and name.  

• Last Stop marker will be added only if a clip which end timecode position is superior 
to the last Start marker timecode position is found 

� Cue sheet export (MT000705) in Generate CD Image Dialog. 
 

� Enable UPC/EAN Code: When selecting a CD or SACD tree info, under section UPC/EAN 

Code, find a new added option to Enable the UPC/EAN Code 

 
� ADR: 

� Add an ADR backup machine control following the recorded loops (MT002393) 

• Through Machine Control it is now possible to record ADR loops onto another 
system (e.g. Pro Tools). 

 
� Record control over SonyP2 improvement (MT002399) 

• Added a machine properties option "Filter the Standby bit" when the controlled 
device doesn't report correctly this status (e.g. Pro Tools 7.4). 

 
� On the fly media Sampling Rate Conversion 

� Still under development  
� The on the fly SRC can be enabled in the All Settings > Application>Playback/Record Page, 

the setting is called: “Real-time Sampling Rate Conversion” and the options are: Disabled / 
Medium Quality / High Quality. 
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� Clips that do not match the project sampling rate will now play correctly if played in timeline. 
� We warn the users that for now the SRC if active will not be applied to the Embedded 

Interchange exports. Meaning that mis-matched sampling rate clips will not be converted 
through SRC. 

� The Waveforms and Playback of those mismatching clips will be in sync 
� For now only supported for BWF, PMF files and Direct Show handler. 

 
� New Libraries and Media Manager Trimmer option   

� Option added in the Libraries/Media Manager menu in Trimmer > Show called : Don’t Show 
Too Large Media/Compositions. 

� This avoids displaying in the Trimmer (when in Show or Auto-Show) Media or Compositions 
having either more than 16 tracks or more than 100 clips (taking too long to mount/online 
referenced media) 

� These values are set by default and are therefore not accessible for the user currently, but 
can be changed in the registry in case of they were not that reasonable. 

• HKEY_CURRENT_USER/Software/Merging 
Technologies/Pyramix/Libraries/Trimmer Dont Show Too Large Mobs Track Count 

• HKEY_CURRENT_USER/Software/Merging 
Technologies/Pyramix/Libraries/Trimmer Dont Show Too Large Mobs Clip Count 

 
� Project Management  

� The Project > New > New Project Wizard has now a new option named “Load a Template”. 
This new option allows the user to select a Project Template and then go to the Next Page 
to setup a Project Workspace (Project Name, Folder and Media Folder) as per any New 
Project. (MT002078). 

� The Project > New from Template menu now uses the New Project Wizard described above. 
When calling “New from Template” the file dialog allows the user to choose a displayed 
template and then the Project Wizard Setup Workspace Page is automatically displayed to 
create a Project Workspace (Project Name, Folder and Media Folder).  
If the option to create a workspace is chosen then all folders are created and all locations 

associated in every settings page and the project is automatically saved in the proper folder. 
If the option is not chosen then the old procedure is applied, manually select a Media Folder 
and Save Project As dialog open. (Request MT000717&MT000224 now closed). 
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IMPROVEMENTS 
 

Version Pyramix 6.1 Release 
� Hardware:  

� MTUSBSync: add mechanism to prevent two applications to access the board at the same 
time (MT2966) 
 

Version Pyramix 6.1 RC3 
� New MassCore version: 

� This New version allows Pyramix MassCore to be supported under Vista SP1 & SP2. 
� MassCore Windows Boot Choice was renamed as “Merging Technologies MassCore” 
� If an older MassCore version is already present in the system, the current installer will warn 

MassCore users that a new MassCore (RTX) version must be installed from the MT Security 
Settings. 

� Procedure if you already have a MassCore version installed: 

• First remove the present version (RTX) by going to the Windows Add or Remove 
Program. 

• Reboot the system 

• Go to the MT Security Settings under the MassCore Tab and install the new version. 
Pyramix / VCube integration improvements: 
� The following apply when VCube is running in the same machine than Pyramix, OR when VCube is 

running on a different machine and it’s network name has been properly set in Pyramix > All Settings 
> Virtual Transport > VCube Options > Associated VCube network name. 

 
� If VCube is running and the All Settings > Virtual Transport > Clients State Saving is set to Save 

Clients State, then when saving a project in Pyramix the content of the VCube Timeline and all 
settings are saved in the Pyramix projects. When the project is reloaded in Pyramix the VCube 
timeline is reloaded accordingly. (Same behavior than the DS Player up to now, but for complete 
Compositions). 

 
� When importing a Composition in Pyramix, if the Video Options of the Import dialog is set to Open 

Referenced Video and the imported composition contains video tracks, then this very same 
Composition file is sent to VCube for importing as well. This works with AAF, OMF, FCPXML, 
MTXML. 

 
� When importing a single Video File in Pyramix using Project > Import > Video Clips, this Video file is 

imported in VCube as well (or in DS Player if the dialog is set to the first option) and placed at its 
original timecode (timestamp). 

 
� A new option has been added in the Mixdown dialog of Pyramix on the bottom of the Post-

processing options: Place in VCube. When the Mixdown process is finished, mixed down audio files 
are sent to VCube and automatically loaded in the timeline, replacing the audio tracks present in 
VCube at that moment. All audio tracks present in VCube are removed, Video tracks are preserved, 
and the new mixed down files are placed at the proper timecode in the VCube timeline, ready for 
final Review and Wrap/Render. 

 
� Project > Import > Video Clip: 

� The module now also imports and places in the timeline the audio tracks of the imported 
video file 

� The behavior follows the Replace/Append/Insert rules as per other (composition based) 
formats. 

 
� ADR Improvements 
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� Project Memory Load improvements 

 
� Project Saving Memory improvements (MT3053) 

� Safer memory handling when saving with low available virtual memory and avoid Runtime 
Errors at save.  

 
� Playback engine improvements (MT3005) 

� Under Settings>Application>Playback Record the “Playback Lookahead Buffer” has 4 
Levels available. The greater the chosen Level, the bigger the PreLoad Buffering. Also 
meaning that the Memory consumption will be greater. Large Level values are 
recommended to allow Playback of complex Projects. 

• Level 1 (0.341 [s]) 

• Level 2 (0.682 [s]) 

• Level 3 (1.36 [s]): Default 

• Level 4 (2.72 [s]) 
� The selected “Playback Lookahead Buffer” settings is reflected at the bottom of the Pyramix 

GUI (level 3 being the Default one) 
� We recommend that all users Reset their Profiling to the factory settings (Under the Debug 

menu). Especially if the Playback Buffering value was customized in the past. 
 

� Mykerinos improvements: New Mykerinos version of drivers for MYK-X30 and MYK-X50 that uses 
less virtual memory are now included into the V6.1 installer 

 
� GPIO SeaLevel PLC-16 now supported under Vista. Referred in Merging Documents as CON-SGU-

0808 
 
 

Version Pyramix 6.1 RC2 
� Pyramix General 

� ADR Export loop list improvement 
� MT Asio Bridge: Now authorizes 96 channels with Extended Native version (MT2816) 
 

� Oasis Key pre-definition 
� OASIS Protocol Eco Class: This key planned for low-cost controllers (such as Artist series 

from Euphonix, as and when these are released for the PC market)  
� OASIS Protocol Business Class: This key enables Oasis protocol for medium range 

controllers (typically Smart AV’s Tango series)  
� OASIS Protocol First Class: This key enables Oasis protocol for upper range controllers 

(such as Merging's Ramses, Euphonix MC5, Harrison or AMS-Neve)  
 
 

Version Pyramix 6.1 RC1 
� Pyramix General 

� Mixdown or Generate CD image, the names of the Mixdown Stems now indicate the 
corresponding names that the user provided in the Channel Strips, only if the Strip return 
from bus is properly indicated. (MT2233) 

� Added Hotkey for "Cursor Auto Return after play" to toggle it on and off in view menu Ctrl + 
Alt + C (MT576) 

� Macros: New Keystrokes tab menu, including:  Enter, Shift, Tab, the Arrows (up, down, left, 
right) and ESC keystroke. (MT2709) 

 
 

Version Pyramix 6.1 Beta3 
� Pyramix General 

� DirectShow handler improvements, for compressed formats (MT2508) 

• Decompression is now done on the fly 

• Better handling of compressed file formats 
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• Default Windows installation should handle most of the common compressed file 
formats. In case of problem with the default Widows Installation, Merging has a list 
of recommended third-party codecs but will not certify any codecs. 

 

Version Pyramix 6.1 Beta2 
� Pyramix Mixer 

� New Mixer Fader Colors   

• Input Strip: white 

• Return Strip: Black 

• VCA Strip (Group): Blue 

• Subgroup Strip: Green 

• Aux Send Strip: Yellow 

• Master Bus Strip (Mono, Stereo, Surround buses): Red 
 

� Mixer: The number of internal buses was increased to 384 IB at 1FS (MT1952) 
 

� Mixer: Added warning messages when mixer cannot be created (MT2389) 
 
 

� Library improvements 
� Optimized Drag & Drop and Copy/Paste of multiple Media and Compositions between 

libraries 
� Optimized Create Offline Library 
 

 
� Fade Editor 

� Added option in All Settings > Editing Page > Fade Editor called Undock Fade Editor when editing a 
Fade to revert the behavior as per version before 6.0. Default is set to Checked (MT2507) 

 

 
� MT Asio Bridge 

� Increased the number of channels available in the MT Asio Bridge 

• MassCore: up to 96 I/O 

• Native: up to 32 I/O 

• Mykerinos Mode: Not Supported 
 

 
� Media Manager 

� For debug purposes the Media Block Size in now reported in the Media Manager 
 

Version Pyramix 6.1 Beta1 
� Pyramix General  
 

� MassCore 

• Allow a larger VST Plug-in Engine Latency buffer size. The maximum value is now 
8192smpl. (MT001925&MT002272) 

• New MassCore memory scheme, improved memory handling (MT002268). 

• MassCore: under Vista not launching at times if 3G of RAM or more were present in 
the system (MT001949). 

 
� New playback engine for better performance (MT002286) 

• A new Playback Preload option available in Setting>Application>Playback/Record 

• The Playback PreLoad can be adjusted accordingly (default value being 1) 
Note: The higher the PreLoad will be the longer the playback Cursor will pause at start 
playback. 

 
� Mixer  
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• New Global status button for Solo, Mute and Overload (MT002325): The new 
buttons are located on the right side of the mixer (next to the fader line) and will 
respectively be displayed if one Mute, Solo or Overload led is ON. Clicking on it will 
reset the related state. 

• Mixer: Allow more than 3 loops in the Mixer; you can now go up to 5 loops. 
(MT002445)  

 
� Workflow performance improvements 

• Optimizations were made to the project save time which should now be much faster, 
the copy/paste of Medias and other editing functions will also benefit from this major 
optimization. 

 
� Improve Native TimeCode accuracy (MT002297) 
 
� Authoring 

• Sony MTS SACD authoring file import: Catalog Number specified as UPC/EAN is 
now copied in the SACD Album UPC/EAN field (MT002310) 

 
� Hardware 

• AES II: Correction of high speed settings in DSD mode 

• MYK-X30: Improvements in word clock locking mechanism 
 

� Waveforms 

• Auto-scale  
- Waveforms improvements (MT001399). A zoom factor option was added 

based on all visible clips available from the View>Waveforms menu. 
- New Option in the Settings>Application>Timeline Layout under Clips & 

Waveforms for the Auto-Scale to consider or not the clip gain if present 

• MYK-X30: Improvements in word clock locking mechanism 

• Waveform Improvements 
- Faster generation after recording 
- Generation while recording for all mediahandlers (BWF, Wav, Aiff, SD2,…) 
- Cancel waveforms is accurate and as soon as confirmed 

 
� TimeCode, Chase 

• MT001386: Fixed. Chase: added option to allow a different midnight crossing 
behavior, when chasing a project laid on the day before & after.    

• Native ASIO: Added support of ASIO 2.0 TimeCode LTC IN                                                            
 

� ADR 

• Importing some ADR loops can cause Pyramix crash (MT001301) 
 
 

� Libraries improvements 
 

� Loading of libraries and projects clips/media faster (twice) 
� Linking of Media within folder and Quick Mounting is much faster  
� Importing OMF files, Reconnect OMF Mobs and Media faster  
� MT001610: Fixed. Global libraries and Document Libraries general improvement requests 

(network created library not refreshed) 
� When linking Media a progress bar is now displayed  
� When canceling a Media Mounting or Browsing no more QuickMount file is saved with 

partial files being displayed. 
 

� Media Browser in the Media Management window improvements:  

• Progress Bar displayed when browsing  

• Browsing can be canceled (if too long for instance)  
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• No more lost clips linking when refreshing a folder in the Media Browser  

• The Media Browser tree structure is now reset when calling Refresh on the Media 
Browser Root (allowing the show newly added folders in the disks) 

• Browsing Folders already in the Mounted Folders structure but in light grey (not 
really mounted but part of the hierarchy) now properly display files. 

 
� When loading project a progress bar is displayed when opening media files  

 
� When loading a project and some Media files are missing the system now automatically 

searches missing files in the folder structure under the project file mounts those containing 
any of the missing files (typically folders like: Media Files, Audio Files, OMFI Media Files, 
etc… and any other, but only those containing any of the missing files) 

 
 
 

� EMC, Controller, Oasis and Ramses. 
 

� ISIS Track access increased up to 96 tracks (LCD) 
� Oasis Key revision.  

• Oasis now comes in three options;  
- First Class: Equivalent to current Oasis key, transparent to current Oasis 

users. 
- Business Class: To be detailed soon.  
- Economy: To be detailed soon.   

• Please contact you local Merging Sale Representative for more details. 
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BUG FIXES  (some fixed bugs could be missing from the list) 

 

Version Pyramix 6.1 Release 
� MT3133: Fixed. Waveform While Recording: If using prompt for name after recording and changing 

name of the clip, the waveforms will not follow. 
� MT3128: Fixed. Automation release points were sometimes ignored and replaced with the after 

released points  
� MT3112: Fixed. AAF Export: Cannot export new recorded clips with enable dubbing  
� MT3110: Fixed. 'Display Waveform while Recording' causes Memory leak if Waveform generation is 

not set to ''Generate while recording" 
� MT3118: Fixed. Automation copy-paste does not consider tracks that are not displayed if not 

connected to mixer. 
� MT2891: Fixed. Playback of mismatch Sampling Rate (vs. Project) clips will generates glitches and 

playback stalls and crossfade points 
� MT3097: Fixed. Quick Convert: Prosoniq Mpex3: Crashes Pyramix if used through Quick Convert or 

Reverse 
� MT3057: Fixed. Recording Pyramix crash in BWF recording (waveform display memory leak). 
� MT3086: Fixed. Render: Memory grows and is not released when rendering (192kHz) 
� MT3089: Fixed. Pyramix Crash: DXD project when initiating Generate CD-Image (RedBook) in non-

realtime 
� MT3082: Fixed. Pyramix does not reconnect the Ramses when a connection timeout occurs 

 

Version Pyramix 6.1 RC3 
� MT2891: Fixed. Playback of Media with mismatched Sampling Rate (vs. Project) clips at Xfade point 

generates glitches and playback stalls. 
� MT2968: Fixed. SonyP2 Reverse Jog/Shuttle/Var at nominal speed interpreted as a Play with some 

Sony settings 
� MT2952: Fixed. Mixer: Internal Bus setting not applied correctly 
� MT2948: Fixed. Striptools EQ Popup does not always follow the active panel 
� MT2929: Fixed. Pyramix Crash after putting a decompressed mp3 file in the timeline 
� MT2927: Fixed. Ramses and Tango Auto open plug-ins window corrupting the Strip tools Values 
� MT2920: Fixed. Record: Recorded tracks are always inserted at the bottom of the timeline. 
� MT2914: Fixed. Pyramix exit will reset the screensaver to 1 minute 
� MT2963: Fixed. Media Manager: Clip Rename does not work correctly if clip is PMF and is already 

referenced in the Timeline. 
� MT2969: Fixed. Metronome: Irregular beats if project is not a 44.1kHz, need to resample bars, beat 

& grid sounds. 
� MT2977: Fixed. Pyramix & VCube opening of project and video clip improvements 
� MT2983: Fixed. Strip Tools EQ Automation not recorded or updated correctly 
� MT2990: Fixed. OMF: Some imported OMF (29.97fps) will start at wrong timecode 
� MT2996: Fixed. Ahead-reading issue in Settings with Playback Level < 3 
� MT2975: Fixed. MassCore: Some  system configuration will not launch MassCore 
� MT2986: Fixed. Fill selection edit option only works once (buffer empty the second time) 
� MT3010: Fixed. Random Clicks in Fades (DXD project) and disappearing clips 
� MT2982: Fixed. Render Rack was not working with SRC 
� MT2989: Fixed. Virtual Transport: Some 29.97fps QuickTime files will be seen as 1fps files 
� MT2997: Fixed. Automation fader will generate a zipper noise (stepping audio levels) 
� MT3004: Fixed. Pyramix or Ovation MassCore not launching on some specific configurations 
� MT3020: Fixed. Virtual Tape was no longer working 
� MT3026: Fixed. Wrong recording placement when chasing a TimeCode 
� MT3028: Fixed. EMC controllers are not updated after a new project load 
� MT3032: Fixed. Convert: converting a DXD project leads to corrupted state 
� MT3037: Fixed. Quick Import not working on compressed files (mp3) if never decompressed before. 
� MT3039: Fixed. MeterBridge and VuMeter both showing too high visual noise whith DXD input, for 

missing to apply the proper 0-20k Filter. 
� MT3044: Fixed. Crash opening or closing certain Pyramix projects 
� MT3035: Fixed. Mixdown drops in non real-time 
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� MT3040: Fixed. Render: Some Renderers will require specific Memory block size allocation to avoid 
crash (ReNOVAtor, make sure you use the latest ReNOVAtor version from Algorithmix) 

� MT3045: Fixed. Render: rendering clip with different sampling rate with SRC ON would cause 
rendered medias to be shifted when source clip's head is trimmed 

� MT3023: Fixed. AES2 DC inputs do not work properly in 192kHz Single Wire - QuadSpeed mode 
� MT3056: Fixed. FX Rack: canceling the display of the Effect Rack will crash Pyramix 
� MT3052: Fixed. Converting DXD files from 352kHz to PMF 88kHz the resulting file is more than 

twice as big as it should 
� MT3049: Fixed. Cannot save some large project Application error and fails to save to Disk 
� MT2988: Fixed. Playback DSDIFF file in DXD project end up with Runtime error due to memory leak 
� MT3011: Fixed. Playback Performance problem on some DXD project (Stalls) 
� MT3021: Fixed. PMF files created in the Pyramix 6.1 versions not recoverable with MediaRecoverer. 

Corrected with the new MediaRecoverer standalone utility. Contact Merging Support if needed. 
� MT3068: Fixed. Render: Pyramix Hang at start play (Renovator) in the Renderer 

 

Version Pyramix 6.1 RC2 
� MT2429: Fixed. VS3 control panel: On a system where Pyramix was installed by another user, you 

might have to run the VS3 Control Panel at log on, otherwise PMX might not launch 
� MT2629: Fixed. Media: Select Used Media option sometimes shows window without clips 
� MT2748: Fixed. ADR Fix column fields that click poorly 
� MT2749: Fixed. ADR Fix fields that loose their values if not closed first 
� MT2808: Fixed. Mixer: using the default wizard mixer will give you an "Invalid Mixer" warning 
� MT2826: Fixed. Editing: Unsplit and undo will make Pyramix crash 
� MT2828: Fixed. Crash unmounting some PMF media 
� MT2838: Fixed. Reconform not working properly in V6.1, partially reconforming 
� MT2839: Fixed. Waveforms While recording not always showing the proper recorded audio, it keeps 

older recorded waveform (only when Wav, MXF, AC3) 
� MT2841: Fixed. Offline Medias cannot be relinked once saving and re-opening a project, random. 
� MT2854: Fixed. Crash when opening certain project at the Media Folder mount. 
� MT2855: Fixed. AutoPunching status is not updated when stopping during punching 
� MT2857: Fixed. Render broken when DSDIFF, BWF, WAV media are used 
� MT2858: Fixed. In some case, media description is out-dated and shows media file size at zero. 
� MT2864: Fixed. Delete with Media: not removing actual clip, after a Media Manager refresh the clip 

re-appears 
� MT2866: Fixed. Relink: Some project do not relink properly (Cantar sounds inverted) 
� MT2877: Fixed. Remove all present loops in the ADR import Loop dialog doesn't work 
� MT2878: Fixed. Loop list file with Tab separator cannot be imported 
� MT2887: Fixed. Authoring: DST file encoding crashes Pyramix 
� MT2863: Fixed. Media Manager: Clip Rename does not work correctly if clip is PMF and is already 

referenced in the Timeline. 
� MT2865: Fixed. OMF import: Some Video OMF imports do not bring all the video clips (missing) 
� MT2882: Fixed. Digitize Session: can no longer go into record on a digitize session 
� MT2853: Fixed. USB Sync Card lost when temperature rises 
� MT2814: Fixed. A composition (region of) won't appear unmounted even if its entire media is 

actually unmounted. 
� MT1174: Fixed. Sony Slave: Auto PEC/REC in Pyramix not refreshed correctly 
� MT2892: Fixed. OMF import: Message of clip audio missing when all of them are relinking 
� MT2898: Fixed. Resizing of VST2 plug-ins UI causes Mixer to resize 
� MXF: Fixed. Allow correct playback of audio from XDCAM MXF files. 
� MT2805: Fixed. Load Change EDL and Reconform not working correctly 
� MT2903: Fixed. FX Rack presets do not reload Algorithmix LR <=> MS 
� MT2905: Fixed. VST Support: wrong Time Info reported at start of realtime Mixdown 
� MT2901: Fixed. Archive: No Audio playback after an Archive with Consolidate When the timeline 

contains wav files. 
� MT2910: Fixed. Striptools initialization and automation problem when several panels and or less 

panels than Striptools instance. 
� MT2906: Fixed. Scrub: Middle mouse scrub no longer works if the player is in Loop mode. 
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Version Pyramix 6.1 RC1 
� MT2201: Fixed. Monitoring: the monitor panel monitors pre-fader instead of post with certain project 

and settings. 
� MT2262: Fixed. Timestretch if done from the Pyramix timeline (CTRL+SHIFT+S) does not apply the 

clip gain, it will reset it. 
� MT2324: Fixed. Avi waveform file generation broken 
� MT2431: Fixed. Dual card shows additional Inputs and outputs in routing matrix 
� MT2629: Fixed. Media: Select Used Media option sometimes shows clips without trimmer 

waveforms and sometimes without clips 
� MT2640: Fixed. Incorrect file name in increment take number (dubbing mode) 
� MT2642: Fixed. Pyramix V6.1 save special as V6.0Sp2 do not keep automation 
� MT2643: Fixed. Consolidate not working, destination folder remains empty 
� MT2644: Fixed. Waveforms while recording Broken 
� MT2647: Fixed. MassCore 48 Base key wrongly limited 
� MT2648: Fixed. Normalize Clip no longer working 
� MT2649: Fixed. Fade Editor: Auto-scale not working properly 
� MT2651: Fixed. Auto-Scale waveforms do not work with PMF 24bit 
� MT2652: Fixed. Fade Editor: Waveforms color update with cursor does not work if in Dynamic 

Waveforms view 
� MT2653: Fixed. Libraries: Clip browse with the media browser are offline once mounted. 
� MT2654: Fixed. Libraries: Clips appear offline in multiple selections if waveforms were not build yet. 
� MT2656: Fixed. Media Manager: Mounted folders not update in tree 
� MT2657: Fixed. SACD Wizard: the DST Estimation will crash Pyramix 
� MT2658: Fixed. Composition Library not updated correctly 
� MT2662: Fixed. Levelizer and Nova not seen in Render 
� MT2663: Fixed. Waveforms not built in timeline if clips in Media Manager had waveforms Off 
� MT2668: Fixed. Snapshot range will break clip group 
� MT2670: Fixed. Creating a new Mixer, when limited I/O, shows error message "An invalid argument 

was encountered." 
� MT2671: Fixed. Transport: Offset in timeline scale vs transport Timecode 
� MT2673: Fixed. Dubbing record clip miss placed 
� MT2674: Fixed. Waveform while recording doesn't display very small clips (<8 pixels) 
� MT2675: Fixed. VS3ASIO Driver crashes with Foobar2000 player 
� MT2677: Fixed. Auto-Scale abnormalities in both modes 
� MT2678: Fixed. Wrong PK2 waveform file 
� MT2685: Fixed. Wrong peak computation with 24bit media 
� MT2665: Fixed. AIFF files in Media Manager are not updated correctly and are corrupted (Only 1 file 

per track and only when waveform are generated on the fly) 
� MT2690: Fixed. Cursor doesn't move during playback when big VST delay in MassCore 
� MT2693: Fixed. SubGroup: Adding a SubGroup to certain Mixers will crash RTX 
� MT2651: Fixed. Cursor goes back a few frames before recording or playback 
� MT2454: Fixed. Automation: Trim function only works with accuracy for selection range but not for 

clip selection 
� MT2701: Fixed. Value in % entered in the Automation Trimming dialog is 0..1 instead of 0..100 
� MT2689: Fixed. Automation: Undo will not retrieve back the automation if clip was moved 
� MT2668: Fixed. SDII file generation crashes PMX (export PT) 
� MT2694: Fixed. OASIS / EMC should not be present in the controller mapping settings page 
� MT2703: Fixed. Export to ProTools session generates an empty session while SD2 media are 

generated correctly 
� MT2704: Fixed. Dubbing Mode; a drift appears sometimes when recording 
� MT2705: Fixed. Dubbing Mode: While recording, the waveform being generated is sometimes 

shifted 
� MT2707: Fixed. Crash in Pyramix exit after deleting recently recorded clips 
� MT2720: Fixed. Chasing Machine sometimes doesn't goto to the correct location 
� MT2712: Fixed. OASIS “Business” and “Economy” keys are not visible in MTSecurityPanel 
� MT2719: Fixed. OASIS Economy key issue with the Artist controller 
� MT2717: Fixed. Cannot rename a media from the media manager 
� MT2713: Fixed. Quickmount file generated by V6.1 will make V6.0Sp2 crash once read 
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� MT2692: Fixed. Media on network will show up as offline once mounting the folder 
� MT2691: Fixed. Pyramix GUI not refreshed correctly after a Mount Referenced Media 
� MT2722: Fixed. Library: loses track reference once dropped in timeline (can eventually crash) 
� MT2723: Fixed. Consolidate: Only works if you turn off the "Skip Generation if original media exists 

on target drive" is turned off 
� MT2724: Fixed. Multiple deletes get PMX out-of-memory with heavy automations 
� MT2725: Fixed. Reconform with change EDL and PMX gets out-of-memory 
� MT2728: Fixed. ADR. The Import Loops function menu does not close automatically close when a 

GPO Play command status active in any playback modeloop list is chosen in the browser. 
� MT2731: Fixed. GPO Play command status active in any playback mode 
� MT2772: Fixed. Same file in 2 folders : Media Manager gives wrong path 
� MT2775: Fixed. MP3 once rendered will result into an empty file 
� MT2774: Fixed. Pyramix: Delete and Undo are slow to operate. 
� MT2770: Fixed. Wrong media is deleted in the media manager. 
� MT2754: Fixed. Export in ProTools format not working consistently Also consult the related Forum 

post http://forum.merging.com/viewtopic.php?f=23&t=1414 
� MT2729: Fixed. Replace Media: Dragging onto existing clip in timeline a media from media manager 

while holding CTRL is broken 
� MT2718: Fixed. Renaming PMF file fails 
� MT2699: Fixed. Changing the name of the virtual track will also change the name of the referred 

track 
� MT2422: Fixed. Cursor jumps forward at stop when delay compensation increases 
� MT2779: Fixed. Disable the windows animations hide/restore when launching Pyramix 
� MT2786: Fixed. Strip/BusTools EQ type mismatch between GUI and remote text 
� MT2789: Fixed. Aborted dubbing record doesn't delete waveform .pk or .pk2 associated file 
� MT2790: Fixed. Media manager mount: Exclusion of jpegs doesn't work. 
� MT2791: Fixed. Media Offline is broken in conjunction with Undo/Redo 
� MT2357: Fixed. Enable/Disable of Strip & Bus Tools EQ section can generate clicks 
� MT2801: Fixed. Setting track's Repro type to all tracks causes 'invalid argument' popup message in 

Pyramix 
� MT2811: Fixed. Close project/ unmount media is slow 
� MT2817: Fixed. Removing 1st StripTools instance from Mixer Page causes Pyramix crash with 1-

Panel display 
� MT2809: Fixed. Media Manager. In some occasion delete with media is locked by a sharing error. 
� MT2812: Fixed. Drag and Drop from Media Manager is slow 
� MT2815: Fixed. Playlist: Deleting multiple Playlist will crash Pyramix 
� MT2822: Fixed. Interchange:  Imported OMF (that has video) end up with Missing Clips in the 

timeline 
 

Version Pyramix 6.1 beta3 
� MT2625: Fixed. Tracks: Adding a new track, leaves previous selection button. 
� MT2638: Fixed. Record: Crash in Dubbing Mode if doing Record>Play>Record 
� MT2628: Fixed. Cannot use Delete media with Accuracy with Media Manager 
� MT2618: Fixed. Pyramix random crash when playing media 32kHz in Media Manager 
� MT2624: Fixed. Render: Aiff files once rendered will become silent. 
� MT2630: Fixed. Render BWF to PMF files adds silent at end of clip in one channel 
� MT2634: Fixed. SubGroup: Cannot solo strip and monitor the effects (SF not behaving like the Aux 

strip return SF) 
� MT2607: Fixed. Some Mp3 files were not seen in Media Manager 
� MT2623: Fixed. Media Files not seen or properly updated if the Folder is not mounted in Media 

Manager. 
� MT2694: Fixed. Some imported AAF files do not re-link to medias 
� MT2622: Fixed. Libraries: Filters options no longer work 
� MT2615: Fixed. Strip Tools EQ section broken 
� MT2612: Fixed. Cursor drag and Goto delayed in stop mode 
� MT2448: Fixed. Playback/Scrub: When you press Shift+Spacebar to play at 1/2 speed, suddenly the 

cursor goes way over to the left 
� MT2639: Fixed. Monitor Peal level no more reported to the Controllers 
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� MT2411: Fixed. When Controller are Offline, Sony Controller must return the Local bit 
� MT2509: Fixed. QT in VT show poor quality (especially in reverse)   
� MT2614: Fixed. VT: QT in VT will crash if jog from Pyramix. 

 

Version Pyramix 6.1 Beta2  
� MT2499: Fixed. Striptools Automation Snapshot doesn't write the correct value 
� MT2526: Fixed. Tracks Header cannot be set to eye enable/disable or cannot enable envelope (or 

waveform with some projects) 
� MT2522: Fixed. Cannot Delete a clip in Media manager if is was previously put in the Timeline 
� MT2525: Fixed. Crash moving Multi-channel clip in the timeline 
� MT2516: Fixed. Editing: performing a Move clip or undo after a Paste and Ripple crashes Pyramix 
� MT2514: Fixed. Libraries: Some loaded libraries will prevent project from being opened after a save 
� MT2455: Fixed. Automation: Automation disappears on clip selection cut. 
� MT2520: Fixed. Wrong waveform display when toggling track arming in dubbing mode 
� MT2488: Fixed. Reconform not working properly 
� MT2519: Fixed. Wrong Vu Meter delay compensation for "DirectMonitor" strip 
� MT2495: Fixed. Automation: must have a way to preserve the previous automation of a clip in 

Automation Cut/copy/paste mode 
� MT2474: Fixed. Strip Tools: GUI Numbering leads to confusion with the Striptool EQ numbering 
� MT2499: Fixed. Striptools Automation Snapshot doesn't always write the correct value 
� MT2446: Fixed. External insert not working properly   
� MT2434: Fixed. Striptools EQ broken in graphic mode 
� MT2351: Fixed.  Cursor goes back a few frames before recording or playback 
� MT2300: Fixed. Disc Write: Some generated DDP2 file in DiscWrite will crash if opening them back 

in Disc Write  (due to CDText Performer field) 
� MT2317: Fixed. Mixer: Some Mixer Snapshots will crash Pyramix if taken from library 
� MT2549: Fixed. Project sampling rate: It is no longer possible to change the Pyramix project 

frequency sampling rate from the Pyramix settings 
� MT2516; Fixed. Clips sometimes have no waveforms and are not playing back 
� MT2513: Fixed. Surround Panner: Crash if mono, SubGroup missing from drop down list and GUI 

missing surround ball. 
� MT2503: Fixed. Sub Group: If you have a stereo multi-bus, the routing windows do not open. 
� MT2502: Fixed. Cannot use Direct Show and MP3 file (crash, not showed, no waveforms,...) 
� MT2501: Fixed. Surround Panner meters display not updating is opened without mixer. 
� MT1276: Fixed. Wrong message in Pyramix when Punch recording is disabled 
� MT2516: Fixed. Clips sometimes having no waveforms and not playing back 
� MT2610: Fixed. Libraries no more transacted and updated properly. 
� MT2530: Fixed. SonyP2 Slave Controller doesn't report the chase status 
� MT2364: Fixed. Punch in at wrong timestamp when slaving to Timecode 

 

Version Pyramix 6.1 Beta1  
� MT002400: Fixed. Interchange: OMF  from ProTools rendered fade files not being removed 
� MT002323: Fixed. Automation: Copy/paste automation does not carry properly the automation at 

paste location                                                                      
� MT002439: Fixed. Library: improved the speed of clip selection and add a progress status display, to 

prevent the users from thinking that selecting a library entry froze the application. 
� MT002464: Fixed. Media Manager: Random crash when selecting SD2 files in media manager 
� MT002466: Fixed. Some Pyramix DXD project will make Pyramix crash at opening 
� MT002354: Fixed. Fade Editor: Memory settings are lost if closing and opening the Fade Editor.                                                                                  
� MT002470: Fixed. No audio Playback after opening a project, unless replacing the medias, this 

eventually cause random crashes if in that state.                                  
� MT002425: Fixed. Fade Editor: Comes out empty of without the recall memory options due to new 

tab workflow.                                                                     .                                                                        
� MT002285: Fixed. Automation: does not update properly after an undo                                                                                                             
� MT002347: Fixed. VST Effect: Plug-in Bidule troubles                                                                                                                             
� MT002444: Fixed. Make ASIO bridge input available in the Monitor                                                                                                                
� MT002438: Fixed. Direct out and bypassed by the delay compensation mechanism                                                                                               
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� MT001878: Fixed. Media Manager: Medias unlinked if multiple projects are opened and closing 
some of them                                                                         

� MT002458: Fixed. Media Manager: When using some file and putting them in the timeline they 
suddenly show up as offline.                                                          

� MT002441: Fixed. Pyramix random crash when recording DSDIFF one file per track in a DXD 
project.                                                                                         

� MT002463: Fixed. Pyramix hang/pause after recording one file per track clips                                                                                                    
� MT002383: Fixed. Snapshot option: Maintain to the next interpolate                                                                                                              
� MT002349: Fixed. VS3 error logging                                                                                                                                              
� MT002443: Fixed. Mixer: on some projects the mixer delay compensation is continuously in the red 

(D)                                                                             
� MT002446: Fixed. External Insert Crash in V6.1 MassCore.                                                                                                                        
� MT002459: Fixed. Media Manager:  Waveforms are not build when selecting some files and 

canceling the waveforms generation will make the clip no longer visible in Media Manager 
� MT002456: Fixed. Pyramix Native: Changing VS3 and VST order on the bus makes no difference                                                                                      
� MT002432: Fixed. Archive: If changes were made to a project and afterwards you do an archive, 

you will not be asked to save those changes if closing Pyramix                    
� MT002263: Fixed. Snapshot to range sometimes comes up empty in window OR with more tracks 

than the selected one.                                                                 
� MT000633: Fixed. Some Mp3 files can cause some crashes, will need Mp3 improvement.  
� MT000453: Fixed. MP3  present in the TL prevents a sample rate conversion of the project 
� MT002371: Fixed. Mixer: Routing Assignment Mouse Click Offset in connection 
� MT002302: Fixed. Convert Text Markers to CD markers  
� MT002350: Fixed. Mykerinos / Daughter Cards Jitter measurement error in ultra and extra low 

latency 
� MT002344: Fixed. Internal Bus disconnection in Mixer doesn't work properly in Pyramix Native 
� MT000135: Fixed. MTFXRack renderer presets do not work 
� MT001421: Fixed. Large Project: deleting empty timeline space takes a longer time then deleting a 

media section               
� MT002171: Fixed. Some avi files will generate click once played back in Pyramix 
� MT001223: Fixed. Some Mp3 files at 256kbs are not seen in the media manager  
� MT001024: Fixed. Mp3: Waveforms display is not accurate, you might see some fade when there 

are none at different zoom level. 
� MT002312: Fixed. Mounting project with wave file take a very long time to moun the referenced 

medias                 
� MT002325: Fixed. Mixer: New Global status button for Solo, Mute and Overload             
� MT002365: Fixed. CD-SACD Authoring UPCEAN codes cannot be reset nor disabled                    
� MT002187: Fixed. Media manager: Selecting a clip for the first time (if scrolling) does not select the 

proper clip 
� MT002271: Fixed. Record: Aux return record will mute the start of the clip, preventing proper 

alignment. 
� MT002275: Fixed. Mixer: If a GPS track is connected the Delay Compensation Indicator "D" Might 

turn red in playback 
� MT002281: Fixed. Crash RTX in DXD when inserting the ModuloMeter plug-in 
� MT002313: Fixed. Autosave was sometimes looping if multiple projects are opened (causing 

repeated Autosave) 
� MT002365: Fixed. CD-SACD Authoring UPCEAN codes cannot be reset nor disabled 
� MT000135: Fixed. FXRack renderer’s preset management do not work 
� MT002139: Fixed. Archive failing when offline media found fixed  
� MT002316: Fixed. Mounting project with wave file take a very long time to mount the referenced 

medias 
� MT002081: Fixed. Media Manager: File selection sometimes hard to make, or will select multiple 

clips 
� MT001092: Fixed. Media Manager: should refresh and see a newly connected USB device / disk. 
� MT002274: Fixed. Libraries: With multiple global libraries open, if Pyramix crashes, next time a 

project is opened no global libraries are connected to the project. 
� MT002320: Fixed. Reconform: Relink to new media function no longer works. 
� MT000427: Media Manager Refresh on a unit letter problem 
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� MT002484: Fixed. Track arming in US monitor mode from a controller doesn't switch automatically 
to Input/Repro 

� MT002483: Fixed. "Slate" LED on Ramses is always on when Talkback is disabled 
� MT002469: Fixed. Midi Timecode Goto sysex badly interpreted by VT MidiSync client                                                                                               
� MT002428: Fixed. Pyramix and Ramses experiencing connectivity problems and slow updates when 

using Large projects 
� MT002455: Fixed. To low DMA bandwidth on some motherboard                                                                                                                       
� MT002417: Fixed. VS3Panel crash when six Mykerinos were present along with the MassCore key 
� MT002318. Fixed. Mykerinos Daughter Cards Cannot use DXD on input and DSD on output on a 

AES daughter card (AES II not affected)  
� MT002369: Fixed. MTUSBSync, biphase out cannot chase Pyramix when PulsePerFrame different 

of 2 
� MT002398: Fixed. MTUSBSync and MTUSB232 drivers not working properly 
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Pyramix V6 Specific Known Issues (Some issues could be missing from this list) 

 
� MassCore 

� Hyperthreading is supported for MultiCore processors only, since Pyramix V6.1 
� MassCore is not supported on a Pentium 4 or Pentium D processor, refer to the Installation 

Guide for the proper supported configuration details. 
� We recommend that you do not use more than 65-70% of the Core resources, to avoid 

intense graphic refresh burst related problems. Three safe core zones have been set. 
Eventually this will be optimized further. 

• 0% to 65% Green zone (best performance) 

• 65% to 75% Orange zone (moderate risk) 

• 75% to100% Red zone (performance could be at risk if major screen redraws are 
initiated by the user).  

� If the Core indicator blinks (red), this will indicate a drop, only be concerned if the drop 
occurred during Playback/Mix down or record. To reset the Core drop simply do a Mouse 
click on the Core indicator, for more information please refer to the appropriate section in the 
User Manual. VST plug-ins users should consult the VST Core Load information also 
available in the User Manual. 

� External Insert plug-ins: The same input and output cannot be used in the External Insert 
plug-in and the Mixer at the same time, they are exclusive to either one. 

 
 

� General 
� Low Memory Condition Warning:  
A warning was added to inform users when the system is reaching Low Memory Conditions. In 
order to save a project under such conditions Pyramix will switch to Save to Disk mode as not 
enough memory might be available otherwise. This warning was added in order to prevent a 
Runtime Error on Save.  
 
Note that the Save time in Save to Disk mode in Low Memory Condition might take a longer time 
since the memory is being dumped to disk in order to allow the users to save their projects. We 
recommend afterwards to exit and restart Pyramix in order to free all memory. 
 
This Low Memory warning threshold can be adjusted by the user if one wishes it to come earlier 
or later. With every systems and workflows being different, Merging leave you the ability to 
adjust when the Warning will show up.  

 Procedure: 

• Close Pyramix 

• Type regedt32 in the run command 

• In the registry go to HKEY_CURRENT_USER\Software\Merging 
Technologies\Pyramix\Settings\Save to disk threshold (this key will only appear if at 
least one save was made using that version) 

• Default value in Decimal mode has been set to 15  
- The higher the value is set, the earlier the Low Memory warning will come 
- The lower the value is set, the riskier it is for you to encounter a Runtime Error at 
save (previous Pyramix versions value would have had this value set to 0) 

 
In the near term, Merging expects to significantly further improve (reduce) the memory 
consumption of Pyramix, especially when confronted with the task of loading enormous libraries, 
over the coming months. Since this is a rather major re-design, we decided however not to further 
postpone the release of Pyramix V6.1 for just this very only annoyance.  
For the long term, the move of our applications to a 64 bit operating system will provide a very 
solid platform to accommodate the ever growing project size requirements of some of our users. 
We are extremely committed to this move but we do need to be clear that it will not be a short 
term solution, current plans put such a move around 12 months away from today and potentially 
towards 2011. 
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� Timeline and Realtime Sampling Rate Conversion: clicks may occur when doing playback or 

mixdown in a region where 2 overlapping clips reference the same media with different 
sampling rate than project. 
Workaround: Convert those medias to the project's sampling rate, prior to using such a 
workflow. 

� MT3138: Delay Compensation: Inserting/Enabling an effect having a non-zero delay (like the 
Bus Tools DRC Limiter) on a Multi-Stem Surround Bus induces an wrong delay 
compensation computation. Only use effects having no delay on a Multi-Stem Bus for now.  

� Waveforms Display while recording: Some systems configurations will not be adequate for 
true performance if the Waveforms Display while Recording option is selected in the 
Pyramix>Playback/Record settings. Mainly due to the Graphic taking too much resources, in 
such case the stop recording might not be responsive. We recommend in such case that 
you disable this option in your Pyramix Settings. 

� Aux vs. Sub-Group:  
In Pyramix Aux buses are intended solely for foldback purposes. They are not intended to 
be used as a means of applying effects, internal or external, to a collection of sources, with 
the bus output re-routed back to an input strip. Effects can however be inserted into Aux 
buses in order to enhance the artists experience. 
Sub-Group buses are intended to be used as conventional sub groups and, of course, can 
have internal VS3 and VST effects inserted and or external inserts. 
Using Sub-Groups buses for mix effects ensures that the full automatic (and manual) delay 
compensation features will function correctly. 

� ADR keyboard is by default disabled. To enable it you must download and run the proper 
Registry Key.  http://download.merging.com/beta/AssociatedTools/ADRKeyboard.zip 

� MT3129: In Render only the DSDIFF Waveforms display is known to be wrong if rendered 
with the Generate Waveforms While Recording option, this will show a higher waveforms 
display level, but actually this issue is only a visual problem as the audio media is fine and 
accurate. Please Render using the Generate After Recording Waveforms option in order to 
avoid such visual problem in DSD or DXD renders. 

� MT2779: Recommendation: Disable the windows animations hide/restore when launching 
Pyramix. We’ve recently observed that when windows are minimized or maximized, the 
execution of programs (like Pyramix, VCube) is suspended during about 200 ms. This 
potentially could have some dramatic consequences concerning the I/O activity. Therefore 
we suggest that the animation of the window when minimizing/maximizing have to be turn to 
off on Merging systems. Without this window animation impacts on programs are not visible. 
This can be disabled from Windows Performance Options (Visual Effects). 

� Quickmount generated with V6.1 will not be compatible with previous Pyramix released 
versions. Remove the Quickmount file if opening a referenced media folder in a previous 
release. 

� Pyramix Projects created in V6.1 will not have a compatible mixer if opened in a previous 
version of Pyramix (e.g. V5.x or V6.0.x). Please use the proper “save special” option in the 
project menu for creation of backwards compatible Pyramix projects. In such a case the 
Libraries must also be saved with the Save as V5.1 & V6.0 option. 

� Multiple projects opened simultaneously: We do not recommend users to have more than 8 
project opened at the same time (due to GDI object limitation). 

� Waveforms: Pyramix V6.1 has a new waveform file format that is PK2, such a PK2 
waveform file cannot be read in previous Pyramix version and in such a case waveforms will 
have to be re-generated. On the other side previous waveforms format PK files (Pyramix 
V6.0 and older) are compatible with Pyramix V6.1. 

� The Render Tool will create a temp file in <user>\Documents and Settings\<user 
name>\Local Settings\Temp). Be aware that Merging cannot change the Temp file patch of 
third party Render (e.g. Algorithmix, Prosoniq, etc…). 
Workaround for Merging Render temp file path change would be to select “my computer” > 
Properties > Advanced > Environment Variables > User Variables and change current 
selected path. Be aware that temp files from some other software will also be written there. 

 
� Third Party Plug-ins 
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� Algorithmix ReNOVAtor for Pyramix: A new version is available with Memory improvements. 
This version will prevent memory related crashes and can be downloaded from 
www.algorithmix.com  

� Cedar: Install issue on certain Vista configurations where you might not see the Cedar plug-
ins after the installation process. The problem is due to erroneous referencing of the license 
manager utility on a vista machine. Please contact Merging Support or Cedar Support for all 
details and workaround. 

� Cedar: Some toolbar icons might be missing if on a Windows XP system. Workaround: 
Disable the Skin option in Pyramix>settings>Desktop Layout. 

� Altiverb: We recommend users to download the latest version available on the Audio Ease 
site. 
 

� Hardware 
� The MADI 1 daughterboard is not supported in multi-board, neither in Mykerinos nor 

MassCore. 
 

� MP3, AC3 Files and other compressed formats support:  
� Default Windows installation should handle most of the common compressed file formats. In 

case of problem with the default Widows Installation, Merging has a list of recommended 
third-party codecs but will not certify any codecs. 

� Vista users warning: UAC (User Account Control) can be blocking the “Essentials Codec 
Pack” at startup. If this is the case, you should see once logged into your session at the 
windows bottom bar a “Windows has blocked some programs” message. You can then 
unblock it from there or deactivate UAC from the Windows Control Panel. 

� No need to install the previous mp3 beta handler since it is now by default part of the 
Pyramix installer. 


